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1 Document aim and conventions

Beside technical data, this document explains product use and function. For possible combination with other
Nanotec products, please ask your Nanotec sales partner. Before using the product, please note document
font styles and conventions.

Underlined text marks a cross reference or hyperlink.

Example 1: Observe our safety notes.
Example 2: Download needed code templates from our website for EMEA / APAC or AMERICA.

Gray bold italics call out menu paths, buttons, tab and file names.

Example 1: Select Home > Connect controller > CANopen.
Example 2: In the NanoJ tab, select NanoJ project and open Analog Input.cpp.

Plain italics mark Freehand entries and foreign-language expressions. They also emphasize words of critical
weight. Alternatively, bracketed exclaim marks(!) give critical weight.

Example 1: Enter Plug & Drive Studio. In addition to users (= Nutzer; usuario; utente; utilisateur; utente
etc.), this document also addresses:

- Third-party users (= Drittnutzer; tercero usuario; terceiro utente; tiers utilisateur; terzo utente etc.).

- End users (= Endnutzer; usuario final; utente final; utilisateur final; utente finale etc.).

Example 2: Protect yourself, others and your equipment. Follow our general safety notes that are gener-
ally applicable to all Nanotec products. Also follow the specific safety notes that apply to this specific
product.

Courier marks code blocks Of programming commands.

Example 1: Via Bash, call sudo make install to copy shared objects; then call 1dconfig.
Example 2: Use the following NanoLibAccessor function to change the logging level in NanoLib:

Y xkxkx C++ variant *xx*xx
void setLoggingLevel (LogLevel level);
The verb to co-click
Co-clicking means a mouse click by secondary key to open context menus etc.
Example 1: Co-click the file, select Rename, and rename the file.
Example 2: Co-click the file to check and select Properties.
Numerical values

Numbers appear in decimal. Hexadecimal notation ends in g pscript h. Objects in the object dictionary notate in
hexadecimal as <Index>:<Subindex>, hon-notated subindices as 00,,. Example: 10034,: 05y, is subindex
5in object 1003;,. And 60404, is subindex 00 in object 6040,

Bits MSB LSB

Each object bit counts up from LSB (bit number 0), ~ BtNummer 7 6 5 4 3 2 1 0

such as data type UNSIGNEDS: Bits |0 1]0[1]0[1]0[1] 2550285

Version: 1.3.2 3
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Count direction (arrows)

lllustrations always count arrow-wards; both example | Max. acceleration (60CSy)

objects 60C5y, and 60C6y, are thus positive.
. / _

Max. deceleration (60C6,,)

Acceleration
.

Version: 1.3.2
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2 For your safety

Before product use, please ensure that all users read, understand and follow the instructions in this docu-
ment fully.

2.1 Warn and risk levels

Please note: our hazard warnings, alert symbols and signal words mark different risk levels.

CAUTION!

é CAUTION warns of possible physical danger!
Minor / moderate injury possible.

» Instruction against unhealthy user errors.

NOTICE

0 A NOTICE warns of wrong operation.
Material or ecological damage possible (not strictly injury).
P Instruction against destructive user errors (= mere material risks).

Note: Explains or simplifies a process by additional information.

Version: 1.3.2 5
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3 Before you start

Before product use, you need to prepare the PC and verify product intent / limits. Via online help, you can
learn how to install and set up projects and how PNDS3 runs. Observe the safety notes in the manual
(www.nanotec.com).

3.1 System and hardware requirements

Plug & Drive Studio 3 (PNDS3) needs 64-bit operating systems. Nanotec recommends controller firmware
FIR-v2213 or newer. PNDS3 offers a special control for firmware update.

PNDS3 64-bit OS requirements Fieldbus adapters / cables
v3.1.7 = Windows 10 m CANopen:

= .NET Framework 4.8 o IXXAT USB-to-CAN V2
m Display resolution 1920x1080 o Nanotec ZK-USB-CAN-1

m Modbus RTU:

o Nanotec ZK-USB-RS485-1 or
equivalent USB-RS485 adapter

o USB cable via virtual comport (VCP)
m Modbus TCP:
o suitable ethernet cable

m Ethernet (REST), EtherCAT,
Profinet:

o suitable ethernet cable

o WinPcap 4.1.3, or Npcap
installation, see Installation and

adapter

3.2 Intended use and audience

NOTICE

Damage: from unskilled staff!
0 » Use the product only for the purpose described in this document.
P Restrict use to expert staff only.
» Follow valid OEM and system prescriptions for all equipment involved.

Plug & Drive Studio 3 (PNDS3) is a free software for easy Nanotec drive commissioning. The underlying
operating system / hardware (PC) is not real-time capable. Never use PNDS3 for time-critical or
synchronous multi-axis motion nor integrate it as a safety component in a product or system.

Add proper warnings and instructions for safe use / operation to each end user product with a Nanotec-
produced component. Submit any Nanotec warning directly to end users. The product addresses skilled
experts in industry use cases alone. Expert means:

m Training / experience in motor and controller handling m Knowledge of valid regulations
m Understanding this document plus Nanotec drive manuals

Version: 1.3.2 6
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3.3 Delivery scope and warranty

PNDS3 comes as a *.zip folder from our download website for either EMEA / APAC or AMERICA. Duly store
and unzip your download before setup. The product package contains:

m Software as an executable file m Current firmware release
m Project templates m Online help file

For scope of warranty, please observe our terms and conditions for either EMEA / APAC or AMERICA. Note:
Nanotec is not liable for wrong quality, handling, installation, operation, use, and maintenance of third-party
equipment! Follow valid OEM instructions.

Version: 1.3.2 7
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4 Your product
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With PNDS3, you parametrize and commission Nanotec drives. Using templates for various Nanotec drives,
you can add your own projects, systems and modules to the modular user interface. The software comes
with a default folder structure (Project, System, Module Group, Module, etc.).

Project

v m System -0)'

A4 E Device Settings
System

~ E Created from Template external Cont... -@'

A4 E Device Settings
Basic Setup
User Units
Pl Tuning
Closed Loop

Inputs / Outputs / Brake

BEEEBEEBBHB

Mano) App

Module (Group)

~ E Created from Template external Cont... 0}'

~ m System1 -'@'

-~ E Device Settings

User Units

EH
E Pl Tuning
@ Closed Loop

Version: 1.3.2

You manage all settings and device parameters in
projects, save these as a file and im- / export them,
say, as a template. Such a reusable Project can have
multiple systems, say, the axes of a machine.

In a project (here: external controller), you create
and store drive systems (here: X-axis). Each is im- /
exportable as template.

You can extend such a reusable System, of at least
motor and controller, by modules or module groups
for encoder, gearbox, brake, settings, parameters,
etc.

By parameters, sortable / poolable into several
modules or module groups, you quickly control all
system elements.

A module (group) contains parameters or controls
(groups) and is im- / exportable, single or grouped, as
template.



4 Your product

Controls Group

[

B craeatiom w > c

« 3 swem >

© [ o [+ cLosep Loop susMoDE
fizz} ° Position Loop for Velocity-Modes
EB serunits
(B PiTuning Real Torque Mode

BHE

Nano) App

Slow Speed Mode

Inputs / Outputs / Brake.

[Conyveodyieop 16
 E—T—()
| E—T—

off ]

~  START AUTOSETUP

Short Auto Setup run

Ao Setup sped in e

Auto Setup

B —( ]}
)

Q. Autosetup

Property editing

BEEBE®

User Units

Pl Tuning

Closed Loop

Inputs / Qutputs / Brake

Nanol) App

Version: 1.3.2
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Add Controls Group
Add to Monitoring Panel

Import Group
Export Module

Copy Module
Paste Controls Group

Remove Module

Properties...
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A Controls group pools single device parameters
(objects from the dictionary in the controller) and / or
Special controls.

You im- / export such a control group together with
set values, say, as template.

Simply co-click an element, select Properties, insert
a visible name, version number, and description: This
way you create your individual user interface.
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5 Installation and adapter

Install the software, set up the adapter — and PNDS3 is ready to go. You find PNDS3 software online as a
zip download.

1. Open the website Nanotec > Products > Software > Plug & Drive Studio 3.
2. Download and extract the product zip file.

3. Run the executable file PNDS3.exe.

4. Only with PNDS3 installed: Prepare your fieldbus adapter (see below).

CANopen

1. Decide: Ixxat USB-to-CAN? Or Nanotec ZK-USB-CAN-1?

2. For Ixxat USB-to-CAN: Download the driver (www.ixxat.com/); install it by hand.

3. Connect the adapter to the computer. For Nanotec ZK-USB-CAN-1: Wait for self-installation.
4. Via correct cable (see product manual): Connect the installed adapter to the controller.

USB: Nanotec Virtual COM-Port (VCP)

Connect the voltage supply to the controller and switch it on.

Via correct USB cable: Connect the PC to the controller (= "mass storage device").
In Explorer > Controller directory: Select cfg. txt (= pdd4ccfg. txtfor a PD4C).
Open the file via text editor (Notepad etc.).

Add the lines 2102 |=0x100000 and 4015:01=0. Save the file.

Restart the controller and check if its COM port appears in the device manager.

S e o

Modbus RTU

1. For Nanotec ZK-USB-RS485-1: Connect the adapter to the computer and wait for self-installation.
2. For other equivalent adapters: Follow valid OEM instructions to install the driver.

Modbus TCP

Configure the IP address of the drive and the ethernet adapter accordingly, as described in the drive manual.

EtherCAT

Install WinPcap 4.1.3 or Npcap and make sure the corresponding driver is activated for the designated
ethernet adapter.

Profinet

1. Install Win10Ocap or Npcap and make sure the corresponding driver is activated for the designated
ethernet adapter.

2. Configure the IP address of the drive and the ethernet adapter accordingly, as described in the drive
manual.

Ethernet (REST)

1. Install Npcap and make sure the corresponding driver is activated for the designated ethernet adapter.

2. Configure the IP address of the drive and the ethernet adapter accordingly, as described in the drive
manual.

Version: 1.3.2 10
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6 User interface (Ul)

Thanks to flexible areas and windows, fitted into the main window or usable stand-alone, you can master a
wide range of tasks. Before product use, please understand the Ul structure.

| o= = ~ | When PNDS3 starts for the first time, you are asked
S— E—— to create a new project: either a blank one or one
s = based on a template.
o ot e .
o
SN

uuuuuuuuuu

D OpenRecent | B Seachoncomputer] [ ] [(D CreateProject

If you create a blank project, the project tree is empty
at first.

If you create a new project or load a template, the
interface fills up according to your needs. This way,
you design your own Ul.

Using the View options in the main menu you can
further customize the Ul by changing the theme,

&) oper - B heme - R showing/hiding features or opening them in separate
windows.

File  Device  View Help

Version: 1.3.2 11
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File Device View Help
& Expert - @ Theme - [0 windows - P Separate - o

4+ [ Template: PNDS 1.50F.. 9 . CONFIGURATION Help Console
" Error List
18} CCREEE. [ Show current values
s 03 Settings . Basic Monitoring 0D Monitor
SO e = Motor Type (# da monitor wioduie ) [ import
() A=z Pole pair caunt % 3
i » MONITOR
L Operation Mode Open Loop / Closed Loop
il
O Fecor Grow Velocity over Speed Pos controlled STATUS
CurrentReduction o M
PID T 4 STATUSWORD
& romas o Aignmen: (3 ) [ —7]
£ Homing A e — Controlword 0x00000000
L Brake Control Slow Speed o] Statusword 0x0000
Ready To Switch On 1]
& Inputs/ Outputs 4 CURRENT SETTINGS
Switched On 1]
¥ CAN Configuration Peak current/torque [mA]
Operation Enabled B
£ Frmwere Update e e ot B
Max current in [%] (for %t und Regler) -
NanoJ P
0 MRz Maximum duration of peak current « — D
» [O Testing System (.. Nanol Program
Device Config Mode
» ATTRIBUTES
Firmware  Interface c.
m Header for main menu (1). m Work desk (3) for user controls etc.

m Display wall (2) for monitoring, object directory, m Project (or side) bar (4) for systems etc.
help etc.

6.1 Header (1)

As a prominent layout bracket on top in the user interface, the Ul header contains all basic functions and
commands relevant to projects, devices and the Ul view.

File

File Device View Help Leftmost above the header, you find the main menu

= ) for project files. You can load new — and save,
O ver Dhowen [ o [} osoens 3] en reopen, edit existing projects.

Device

e B, Oz | (A @ | Eos (B || O s @iz Read, write, and save device parameters. Govern
NanoJ programs and fieldbus network (with
CANopen).

Set Parameters: Transmits the selected parameter
values to system-connected controllers.

Version: 1.3.2 12



6 User interface (Ul)

v PARAMETER VALUE TRANSFER

[] show selected parameters

Name Address Current  Marked
Motor drive submode select [0x3202:0x00] 0 [
Bit: 6
Pole pair count. [0%2030:0%00] 0 50
Motor drive submode select [0x3202:0x00] 0 1
Bit:0
Peak current/torque [mA] [0x2031:0%00] 0 1000
Max current [0x6073:0x00] 0 1000
Maximum duration of peak current [0%2038:0402] 0 0
Motor drive submode select [0x3202:0x00] 0 o
Bit:3
Motor nominal current [mAl, (Datash...  [0x2038:0x01] 0 1000 O
Sl unit velocity [0x60A9:0x00] 0 11796430 O
Mask: 255
Shift: 16
Sl unit velogity [0%60A%:0x00] 0 18176 O
Mask: 255

File  Device  View Help

|_E Expert -~ g Theme - Windows - Z Separate -

IE Expert - $ Theme -

Eﬂ Expert
[ | Intermediate ted from Template exi

|:| Basic

ry —ysteml

Help

File  Device View Help

@ Help G) About

Version: 1.3.2
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Note: You can select parameters to be set by ticking
them. You can find a list of all used parameters under
Parameter Value Transfer if you click the respective
system.

Get Parameters: Reads the values of system-
connected controllers.

Store Parameters: Stores Set-transmitted values of
system-connected controllers.

Restore Factory Default: The stored objects are
discarded, with the exception of the category Tuning
and the fieldbus-specific category. You can find
further details in the chapter Discarding the saved
data in the manual of your controller.

The change does not take effect until after the
controller is restarted (Restart Device).

Here you can customize the Ul by changing the
theme, showing/hiding features or opening them in
separate windows.

You can also set the User level, to govern user rights
for the following roles:

m Expert: Project owner with all rights. May create
and edit projects, rights, visibilities, etc. Governs
via Properties, for each single parameter up to a
complete Controls group, who may see and edit
exactly what.

m Intermediate: May change device parameters, but
can't edit a project.

m Basic: Similar to Intermediate, but often gets
fewer editing rights from Expert.

Open the online help or PNDS3 version info.

13
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6.2 Project bar (4)

This side bar diplays your loaded project as a tree list by which you create the user interface. Note: De-
pending on assembly, you can check connections and attributes of all tree list items in the work desk (3).

Tree list

You find the project bar in the very left of the user
fffff - screen.

A project (here: for a PD motor) tree-lists all systems

_ and the items therein (see also Project setup). One

project and one system are minimum; further items
v [g systemt s are optional and later on define the entire Ul layout.

v HH Device Settings System 1 contains the module groups Quick Start
with modules for the basic settings and Application

Basic Setup Settings with further controls and parameter groups.

User Units
Pl Tuning
Closed Loop

Inputs / Qutputs / Brake

EEEE®EE

MNanol App

— i = Foreach module, you may add one or more controls
~ | ==~ groups to the work desk (3) further to the right.

Version: 1.3.2 14
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Project > System

A system represents a motor with controller, that is,
one per motor in a multi-axis application.

~  BUS SETTIN

— _-ﬁ
Add New System

mport system

~ m System1

1. To set up a system: Co-click the project.
v E Device Settings

Paste System 2. In the context menu: Either create a new system
via Add New System.

3. Or fetch an existing one via Import System.

@ Basic Setup

Properties... gs

E User Units

Adapter
0 bl Tominns
() vew [open [E) sove [ savens B e 4. A new node (= blue) appears in the tree list.
5. To name it: Co-click the node, select Properties.
v Bl craed rom tempise sneraiCon.._ D~ | |~ conecmon Note: You can edit any object via Properties
~ E Device Settings Add Module
Add Module Group
@ Basic Setup
Import Modules Group
IiE User Units Import Module
IE (i Export System nat
Copy System
IE Closed Loop Paste Modules Group ;
@ Inputs / Outputs / Brake Paste Module —
Remove System =
@ MNanol App
E’roperties..J)
i Key Value
_| Ssemi] 6. Inthe Properties window: Name the system as
| | needed.
Versi . . .
een 7. If needed: Versionize and describe the system.
Description | System1] You can add a string for the device name and
P | PD3| flrmwarg version, WhICh should be checked after
connecting to a device.
Check fi 2213 .
Sek e | | 8. After last entry: Set a tab stop (so that all is
stored).
9. Assemble the system with module groups (see
below).
Project > System > Module group
v Ej Lreateq Trom iempiate external Lont... 5 ~ CONNECTION

A module group bundles several motor functions (=

__mm_m modules). Depending on assembly, you can check its

v HH Device settings Add Module connections and attributes in the work desk (3).

" Add Module Group ]
Basic Setup

(EEH 1. To set up a module group: Co-click the system.
Import Modules Group .

\HH  User units Import Madule 2. In the context menu: Either create a new module

[HH  PiTuning Export System ha group via Add module group.

BH Closed Loap Copy System | 3. Orfetch an existing one via Import module group.

las Paste Modules Group je

|[EH  inputs / Outputs / Brake Paste Module =

E Wl Remove System =

lus, ano) App

Properties...

Version: 1.3.2 15
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hd I ﬁ' System1 B
@ Basic Setup Add Module
@ User Units Import Module
Export Modules Group
@ Pl Tuning
Copy Medules Group
\iE Closed Loop Paste Module
@ Inputs / Outputs / Brake Remove Modules Group
E Mano) App I Properties... l
Key Value
_ | Aoplication Seu-mgS|
Version | |
Description | |

Project > System > Module group > Module

v LE System1 -

@ Basic Setup Add Module

Import Module
Export Modules Group

@ User Units

@ Pl Tuning
Copy Medules Group

Paste Module

E Closed Loop

E Inputs / OQutputs / Brake Remove Modules Group

bt FIKIVIVVARKLC

IE User Units Add Controls Group
Add to Monitoring Panel '
@ Pl Tuning
Import Group
@ Closed Loop Export Module :’_
@ Inputs / Outputs / Brake Copy Module —
Paste Controls Grou
@ MNanol App :
Remove Module
Properties...
Key Value
Version | |
Description | |
Add to Monitor |:|
Version: 1.3.2
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4. A new node appears in the tree list.
5. To name it: Co-click the node, select Properties.

Note: You can edit any object via Properties.

In the Properties window: Name the module
group as needed (here: Controller template).

If needed: Versionize and describe the module
group.

After last entry: Set a tab stop (so that all is
stored).

. Assemble the module group with modules (see

below).

A module allows you to add a single motor function (=
parameter set etc.). Depending on assembly, you can
check its connections and attributes in the work desk

3.

1.

To set up a module: Co-click the module group
(here: Controller template).

In the context menu: Either create a new module
via Add Module.

Or fetch an existing one via Import Module.

A new node appears in the tree list.
To name it: Co-click the node, select Properties.
Note: You can edit any object via Properties.

In the Properties window: Name the module as
needed (here: Communication settings).

If needed: Versionize and describe the module,
add it to a Monitor

After last entry: Set a tab stop (so that all is
stored).

16
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Project > System > Module group > Module > Controls group

Llosed Loop LiTrerental >elect

l=ag)

Limit switch option ¢
—a 1 —— ]
E Nanol) App "__Add Controls Group |

Add to Monitoring Panel

uT
Import Group
Export Module
Copy Module i
Paste Controls Group

[Tl

Remove Module

Properties...
T | | CIOSC Brake IOe time

v START AUTOSETUP = I
Short Auto Setup run [} Add Faramerer
/Add Special Controls
Auto Setup speed in %o o ———
Set Group
Auto Setup Get Group
Mark Group
®  Autosetup Unmark Group
Export Group
~  MEASURED RESULTS Copy Group Controls
Paste Control
Resistance [Ohm] 0E+00 B —
Remove Group
Inductance [H] 0E+00
i g Pmpemes/j
Magnetic flux [Vs] 0E+00 - =
.
Key Value
_| New control group|
Version | |
Description | |
Visibility Basic ~
Editability Basic ~

6.3 Work desk (3)

A controls group bundles individual operating
elements or parameter sets.

1.
2.

To set up a controls group: Co-click the module.

In the context menu: Either create a new controls
group via Add Controls Group.

Or fetch an existing one via Import Group.

In any case, the controls group appears in the
work desk (3).

Right there: Co-click the group and its Properties.
Note: You can edit any object via Properties.

In the Properties window: Name the controls
group as needed.

If needed: Versionize and describe the group.
Note the pull-downs for granted viewing and
editing rights (here: both Basic).

After last entry: Set a tab stop (so that all is
stored).

At the work desk, in the user screen's half-left, you edit the properties / contents / controls of your project and
systems. Depending on assembly, different tabs are above the worktable:

An Attributes area accompanies all items (also module groups); Bus settings, by contrast, only the project
itself. The Connection settings tab, finally, is for systems only; and Configuration is only for modules. Each

tab opens different aspects:

Controls groups Operator clusters

Parameters operator values

Controls group > Parameter

v START AUTOSETUP = I

T —
ST [

~Add Parameter _
‘Add Special Controls

Short Auto Setup run

Auto Setup speed in %o
Set Group
Auto Setup Get Group
Mark Group

Unmark Group.

§ Autosetup

Export Group
¥ MEASURED RESULTS Copy Group Controls
Paste Control
Resistance [Ohm] 0E+00 S —
Remove Group
Inductance [H] 0E+00

Properties

Magnetic flux [Vs] 0E+00

Version: 1.3.2

Special controls reature operators

Complex controls wmuyti-level operators

1.

To add a parameter: Co-click the controls group
and click Add Parameter.

17



6 User interface (Ul)

\YNanatec Add parameter to : “Brake Settings" group a
Name Access Index  Sub

(0x1000) Device Type
(0x1008) Manufacturer Device Name
4 (0x4041) Device Id

WNanatec Add parameter to : "Brake Settings” group a

[[] expand / Collapse Al Filter:
Name Access  Index Sub
’ (0x1000 ) Device Type
> (0x1008 ) Manufacturer Device Name

(0x4041 ) Device Id

Y Nanotec Add parameter to : *Brake Settings” group o
Please select visual representation from the list below
Standard Control
O &
Read Only Control
Bit Control
O &
Drop Down Control
No options available (H
Drop Down Listbox Mask Control
No options available &

Read Only Key Value List Control

Colored List Box Control

E

Controls group > Special controls

~ CONFIGURATION VL monitor

Console
[W] show current values

NanoJ
v CLOSED LOOP SUBMODE =

“ing
Loop for Velocity-Modes Only Velocity loop Only Velocity loop Add Parameter [
AAdd Special Controls
poment o (AddSpecaicomroi) [y

Set Group
Jue Mode OFF Get Group NIT
Dt
pabezit eI Unmark Group TUS
“« . |
Export Group s
v START AUTOSETUP Copy Group Controls
Short Auto Setup run (no flux measurement) ~ ON OFF Paste Control
Remove Group
Auto Setup speed in %o o [ ion]
Properties
Autosetup

Version: 1.3.2
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In the pop-up: Enter device or 0x4041 to filter for
the Device Id object.

You may expand objects by mouse (or tick at
Expand all).

Click Device Id and Next (if wrong: step Back).

In the next pop-up: Select the visual reprentation
and click Finish.

1. Co-klick a controls goup to open its context menu.
2. Select Add Special Controls to open the Complex

controls list.

18
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b Nanatec’ a 3. Inthe pop-up: Select the needed item.
ComplexGoe | | Device Go 4. To confirm: Click Add.

Control List

Autosetup

otion |es

Nanol Control
Scripting Module

Memo Text

Preview Complex Control

Jog Mode
Velocity [rpm]

=

6.4 Display wall (2)
The display wall contains the monitors, error list, current OD values, properties, help and console.

Several tabs facilitate navigation in the display wall, in
the user screen's upper right.

Monitoring Trace Log OD Monitor Help
Console Error List Nano) Properties

Currently no errors occurred

* Add In the Monitoring tab, you combine either single or

> MONITOR = grouped monitors to track individual system behavior
in real time.

> STATUS

1. To set up a monitor: Co-click the tab Monitoring.

2. In the context menu: Either create a new monitor
via Add Monitor Module.

Or fetch an existent one via Import Module.

~  LIMITS SETTINGS
~ CURRENT LIMITS
Peak current/torque [mA] 2500 3

Motor nominal current [mA), (Datasheet) 2000

The bottom part of the monitor display contains

Hascment e always the system monitor which shows the current
Maximum durafion of peak currant ° device and connection status information.

“  SPEED LIMITS In the tab Trace Log you see live the messages that
T ) U U 20000 are transferred via the filedbus.
Max profile velocity 30000
Max acceleration 5000
Max deceleration 5000

¥ POSITION LIMITS
« I——— D

Version: 1.3.2 19
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[ & Read]‘ @ Dump]‘: [ Impcrt” - Cumpa\e]‘: ] Save]

i

OD Description Index Sub Index Value Hex Bin
BOOLEAN 0x0001 0x00
INTEGERS 0x0002 0x00
INTEGER16 0x0003 0x00
INTEGER32 0x0004 0x00
UNSIGNEDS 0x0005 0x00
UNSIGNED16 0x0006 0x00
UNSIGNED32 0x0007 0x00
REAL32 0x0008 0x00
VISIBLE_STRING 0x0009 0x00
OCTET_STRING 0x000A 0x00
UNICODE_STRING 0x000B 0x00
TIME_OF_DAY 0x000C 0x00
TIME_DIFFERENCE 0x000D 0x00
DOMAIN 0x000F 0x00
Number of entries 0:x0020 0x00
COB-ID 0x0020 0x01
Transmission Type 0x0020 0x02
Inhibit Time 0x0020 0x03
Reserved 0:x0020 0x04
Event Timer 0x0020 0x05
SYNC start value 0x0020 0x06
Number of entries 0:x0021 0x00
1st object to be mapped 0x0021 0x01
2nd object to be mapped 0x0021 0x02
3rd object to be mapped 0x0021 0x03

Ath nhiart fn ha mannad

- stunmveLoaTy
Sivaasty

M2 MhenA

- FEED CONSTANT

Monitoring

Console

Trace Log

Error List

Plug & Drive Studio Console
Type "help' for more information.

> 3202
>1 xeeoe 0001

yes, calegor. apptcation

is subdx st o ol open g (3 ool
d e

e logca

e

0D Monitor

NanoJ

Help

Properties

G000 0D0O ©00O 0000 ©ODO 0000 0008 0081
[Motor drive submode select]

= 32808=

Monitoring

Console

Currently no errors occurred

Version: 1.3.2
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Error List

OD Monitor

Nano)

Help

Properties
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OD Monitor: Lists all objects from the controller's
dictionary, together with their current values. For
updates: Click Read.

To save the list as a text file on the hard drive: Click
Dump. Keep the text file with current values ready in
case of support enquiries.

Ypu can import an already saved dump file, compare
it with the current OD and save it on another
controller.

Help: Displays the description of the currently chosen
element (OD object).

Console: Use this to quickly read/write.from/to the
device's object dictionary.

Type <od index>:<od subindex> for read.

Type <od index>:<od subindex>=<value> for write.

Error List: Here you can read the actual errors.
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In a project, you manage your devices, settings, connections, etc. Note: Ex works, in the software's
templates folder, there is a sample project each for an external andan integrated controller. Nanotec

recommends using these templates.

Load / Create a project

e [} seen 3] em

Motor® D ~ CONFIGURATION

~ FIRMWARE UPDATE

File  Device \View Help

D New D‘ Open m Save 1’ Save As E Exit

If needed: Name the project

Add Mew System

4 I;_II System 1 Import System

+ [3J Quicksta PasteSystem

Key Value

Project name | Progjct 1|
Creation date 25.07.2023 s
Version | 1|
User level Expert v

Protection Write Mechanics |:|

Version: 1.3.2

. In the user screen: Visit the file menu (1)

. Preferably use Project > Open to select an

existent sample project for template.

. Or, for a new one instead: Select Project > New.

. If a pop-up wants to store the current project: Click

Yes.

m No will close the project unstored and without
backup.
m Cancel will just close the pop-up.

. The newly loaded selection appears in the project

bar (4)

. Go to the Project bar (4).
. Co-click the current project and Properties.

. In the Properties window: Name, versionize,

and describe the project. Note the pull-down for
granted user rights (here: Expert).

. After last entry: Set a tab stop (so that all is

stored).
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7 Project setup

Load / Create a system

~ E‘n System1

~ E Device Settings
E Basic Setup
E User Units

~  BUSSETTI

Add New System

Import System

Paste System

Properties...

Adapter
i Key Value
e =
Version | |
Description | System1 |
Check device | PD5|
Check firmware | 2213]
Connect to adapter
~  BUSSETTINGS
Bus Type s g
USB Settings
Aaspter vssus 3
(@ Comectto agepter ]
( () Scan Devices
Device To System Links
Location Connected Device System Connect

Connect to device

v BUS SETTINGS

Bus Type usB ~
USB Settings
Adapter USB Bus v ) Scan Adapters
©  Disconnect adapter

Device To System Links

Location Connected Device stem Connect

" m Sl > Bus Type uss

v B Device Settings '
B e =
B vt Adapter USB Bus. v ( 4 Scan Adapters J
(£ i
i e
(BB inputs / Outputs / Brake. T
(BB Nanol App n

) Nanotec’

PLUG & DRIVE

In the project: Preferably use Import System to
select an existent sample system for template.

. Or, for a new one instead: Select Add new

system.

In the Properties window: Name, versionize,
describe the system as needed.

. After last entry: Set a tab stop (so that all is

stored).

. Repeat for each additional system.

In the project bar (4): Select your project.

In the work desk (3): Open the Bus settings tab.
In the Bus settings tab: Select the Bus type.

. Check setup by Scan adapters. If no result: Set up

an adapter and check again.

. Select the needed adapter.

In the Bus settings tab: With the adapter linked,
you can see all available devices.

. Click Scan devices. Check Connected device.
. By Pulldown: Select a system to link your device

to.

4. You can link / unlink the device via Connect icon

(here: green).
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Select the OD file

PNDS3 shows objects that match the controller firmware with correct OD file only (object dictionary). If
the system is linked, a Object Dictionary Entries tab shows if the correct OD file is loaded. Otherwise, the
generic file Common OD loads, by which you reach available objects of all Nanotec products.

1. Select the system.
2. Open the Object Dictionary Entries tab.

Object Dictionary Entries m Common OD: Reloadable via Remove OD File
Comect oD m OD file of choice: Loadable via Change OD File
- Device Name / Code  : PD4-C5918X4204-E-01 / 43 . .

(B removeonme ] Poe i o m Firmware-correct OD files for all Nanotec control-
([0 Load From Clowd | i yare version : FIR-v2139-B1022383 lers: In the Firmware package on the PNDS3

Serial Number © B958420 20/23-0010 . . H

oDl : website or via Load From Cloud (internet access

necessary).

Wrong OD files report an error (= red).

Version: 1.3.2 23
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Via Special controls, you add Complex controls and Device communication settings to the user interface.

Both help you to use advanced controller functions.

Basic principle

+  CONFIGURATION

v CLOSED LOOP SUBMODE

LU monior
Console
Show current values

NanoJ

Loop for Velocity-Modes Only Velocity loop Only Velocity loop Add Parameter —
Add Special Controls
gt o [Essaspecaicooei] | oYy
Set Group
ue Mode oFF Get Group NIT
Mark Group
ed Mode Unmark Group \TUS
‘ e
Export Group .
v START AUTOSETUP Copy Group Controls
Short Auto Setup run (no flux measurement) ON OFF. Paste Control
Remove Group
Auto Setup speed in %o 0 1000
Properties
Autosetup
Y Nanotec' a
Complex C... Device Co...
Control List
Autosetup
) s ]
Totion Test
Nanol Control
Scripting Module
Memo Text
Preview Complex Control
Jog Mode
Velocity [rpm]
I G)
)
sa

8.1 Complex controls

Special controls define and monitor (as macro
collections) the system behavior. Depending on
assembly, you can check their connections and
attributes in the work desk.

1. To set up complex controls or device
communication: Co-click the controls group.

2. In the context menu: Select Add Special Controls.

3. Complex controls? Device communication
settings? Open the tab of choice.
4. Select the needed item and Add.

— The control / setting of choice appears in the work
desk.

With the Complex controls macro collection, you create your own controller functions. Next to Autosetup
and Firmware update, these include Jog Console, Motion Test, NanoJ Control, Scripting module and Memo

Text.

Autosetup

Autosetup detects the motor type and connected sensors (encoder / Hall sensors).

Version: 1.3.2
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CAUTION!

Injury: from abrupt motor travel after auto-setup (= parameter loss)!

» For motors with integrated controllers: Avert auto-setup (since it comes factory-run already).
A » Otherwise: Restart the motor after auto-setup (homing alone won't suffice).

» Stay clear of moving motor parts.

» Touch the motor at standstill only.

NOTICE

Motor malfunction: from auto-setup user error!

o » Close possible NanoJ programs (object 2300,:004, Bit 0 ="0"; cf. 2300h NanoJ Control).
» Keep the motor load-free, and freely rotable in any direction.
» Don't touch the motor.

Auto Sehup As long as the motor on the controller or the feed-
' | back sensors (encoder / Hall) remain the same: Run
~ Autosetup only once, on initial commissioning.

Firmware update

Nanotec recommends controller firmware FIR-v2213 or newer. Please find the current version in the
Firmware folder on the PNDS3-website or via Load From Cloud (see Select the OD file internet access
necessary).

Open or add theFirmware update control.
Click Load from file.

Select a firmware file and click Open.
Device name: PD4-C5918X4204-E-01

Hardwareversiors 006 PNDS3 checks via product code if the chosen file
Firmware version: FIR-v2139-B1022383 flts to the product

Product code: 3
5. Click Update device.
[ 9 oadrie | [ 41 Cloudupdate | [ Remove | [ & Update Device | 6. Firmware Updates itself.

Firmware Update

File name:

File firmware version:  FIR-v2213-B1031134-9703408
Product codes: 1:2:3;23; 39;43

e

Note: The chosen firmware file will be stored as part
of the project the next time the latter is stored. If you
don't want this to happen, click Remove from project

before.
Jog Console
e Via Jog Console, you test the motor in velocity mode.
e You can select two target speeds. The motor runs
G = /&8 as long as you use the mouse to press the button for
GO = 1GD left / right rotation.

Note: The console may be deactivated, in case the
controller is currently also connected to an external
PLC.
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Motion Test

Motion Test

Mode: | Position Absolute v Loop: | Endless v
sat ][ sop | Set Current Position ([

Step Position Vel  AccRamp DecRamp (U

1500 50 200

15
=3
s

oo (0] (+] (8]

2 1500 50 200 500 1000 [E] [E] [E]

NanoJ Control

Nano)

NanoJ Project New NanoJ Project <> Show Code
NanoJ Settings
) Show Settings
Default NanoJ Settings v
v INPUT-SELECT
Input 1 Itrem 1 Description v
Input 2 Itrem 2 Description v

\bNanotec! Nanoj Window Y

system1 | New NanoJ Project

5]

18 /7 set mode "Profile velocity'

17 Rer
22 U32 targetvelocity = o

24 17 set the tary
25 o0d_urite(exser

27 // Request state "Ready to switch on”
Wano? Console

B ® [

)
=)
-
El
O]
®

Scripting Module

~  TEST VELOCITY

Scripting Module Definition

| Stop Motor” -

Scripting Module Add |

‘ Run Velocity 100 rpm (® J[ v ][ }

. Console

Version: 1.3.2
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In Motion Test, you test the motor in position / ve-
locity / torque mode. Your options include target val-
ues, acceleration / deceleration ramps, repetition cy-
cles, test run duration etc.

By adding a NanoJ control, you create a new Nano
project which at first inludes some example code and
has no settings / variables declared. You can then
Import an existing project or Export your project after
editing the code and defining some custom settings.

Click Show Settings to display the current settings (if
any) in the section below. You can delete or rename
the current settings, create new settings, or load the
default settings. For more details, see chapter NanoJ

App.

Click Show Code to open the editor. You can open
it in a separate window for more convenience: Main

“Bm===l  Menu > View > Separate > NanoJ.

Build the project to compile and be able to transfer to
the controller and run the NanoJ program.

In the Scripting Module (only available for expert) you
create scripts consisting of Buttons which execute
one or more commands each.
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. You can link following commands to each Button:
T &

m ReadOd: Reads the value from an object and

Scripting Module . .- -
writes it into a variable.

o ed e e m WriteOd: Writes a value into an object.
Commands m CalculateFormula: For operations with previosuly
( @add | | Z Edit ] [ moee | assigned variables. E.g.: z = 5.67*x+y*3.98-x*y
c dType C d Text m Sleep: The script waits at this position for the set
ReadOd Status=READOD(6041:00) time (in milliseonds).
Steep Step 1 ms m Sleep: The script waits at this position until the

set condition is fulfilled (value of an object is

compared to a given value).

Command Definition

CalculateFormula V| Status| :| ‘1024| INT i
( vmpy | [ ®cunca |
Memo Text

Adds a freely editable text box.

8.2 Device communication

With these controls, you parametrize the device communication. Note: Coding switches for setting the com-
munication parameters overwrite the software settings on some devices. For details: Follow valid OEM in-
structions.
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9 Oscilloscope

Via Oscilloscope, you monitor and control in real time the current value of device parameters from the object
dictionary, say, for recording.

= To open the oscillosope, go to the Main Menu > View
> Windows and select it.

eme - Windows - Z Separ

'| Oscilloscope ¢

V[ VIO
Nano)

mplate

[ A

Under Settings you can configure the following:

m Continuous: If chosen, the oscilloscope starts

[ ] Continuous imeediately and runs continuously, until the buffer
is full (if On-Device) or after the set Duration

@ software expires (if Software is selected). If not selected
you can further define the conditions for start/stop.

@) Repstetive Overlap 1 m Start: Immediate, Condition (On-Device, as soon
as a parameter of choice changes), or Motion test

Start Immediate v (Software, Motion test triggers the scope).

m Stop: Duration (of recording) or manual.

Duration [ms] | 60000|

Sampling Period [ms] | ‘IO|

In the right bottom corner you can add channels by
selecting from the object dictionary or remove them.

Name Value  Color_View
[) System1 (se... v 6044:00 vl velocity actual value
0 []  systemi(se.. v 203905 Actual current
0 [V]  Systemi (se.. v 606400 Position actual value
) System1 (se.. v 60FD:00 Digital Inputs

v | View1

v [ View1

ololofe

~ [ View1

~ | View1

For each channel you can define under Properties in

(= Add) (= Remove ) (& ApplySystem ) Current System: System1 Properties =
#_on_Hide System 0D Name Color « which view and how it is shown.
D VI 1] currentSyst.. 04 | view1 v
1[0 [ currentSyst.. v 203905  Actual current o
2 []  Current Syst.. v 606400 Position actual value Offset (Min) 0 %
3 [ currentsyst.. v 60FD:00 Digital Inputs Offset (Max) 0 %
Line Style Solid v
Mark Style | None v
« » | Format Decimal Vv -
- For recording, you open a new (or import an existing)
© N ) (@ fmen) (S 0 oo ) » . . - .
- - oscilloscope in the tab above the settings and click
=== Start.
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10 NanoJ App

With the NanoJ App you create a NanoJ program based on the NanoJ Libraryby editing the Default Settings
or creating new settings.

TIP

\,

2@( Further information on NanoJ Library and programming with NanoJ can be found in the Know-How
section of the Nanotec website and in the respective product manual.

,

Nanal Click Show Settings to display the current settings
e et Nanol he in the section below. You can delete or rename the
Settings Detaun v Show Sertings current settings, create new settings, or reload the

Add new Nanol settings

default settings.

Rename Nanol settings
Add default NanoJ settings

Nofescion Click Show Code to display the NanoJ code that
e 1 corresponds to the current settings.

Delete Nano) settings

iz Vs Under Properties you can edit the variables of the
Name  Description Data Type Control T Value Reference __Value Enabled Visible * current Settings or create new variables.
Nolnput  Nolnput int Selection InputSelect 0
Input1 Input1 int Selection Inputselect 2
Input2 Input2 int Selection InputSelect 3
Input3 Input3 int Selection InputSelect 4
Inputd Inputd int Selection InputSelect 5
[ I P— = Catctinn bttt o A @A =
Nano) Enumerator
Inpuselect o

ProfileSelect

None Ne Reaction

Stop Stop

StartProfile  Start Profile XYZ
[

ProfileSelect]  Profile-Select 7

ProfileSelect?  Profile-Select Y_

alw|w|=]o
IR Q| & & &
|} K& & &

With the Default Settings of the NanoJ app, you can:
m Assign a function to each digital input of your controller.

o Enable (release) the output stage.
o Select preset driving profile and start/ stop it.
o Home switch
m Assign a mode/driving set to each driving profile.
m Adjust each driving set (set points, ramps etc..).

After editing or creating the settings, click Show
_ Code and save/export the NanoJ program or have it

B - - B , compiled and transferred to the controller and run.
L= * o L

1 ma|

System1 | NanoJ App

Build current NanoJ Project

2 ma|
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© 2025 Nanotec Electronic GmbH & Co. KG. All rights reserved. No portion of this document to be repro-

duced without prior written consent. Specifications subject to change without notice. Errors, omissions, and
modifications excepted. Original version.

Nanotec Electronic GmbH & Co. KG | KapellenstraRe 6 | 85622 Feldkirchen | Germany
Tel. +49 (0)89 900 686-0 | Fax +49 (0)89 900 686-50 | info@nanotec.de | www.nanotec.com

Document

1.0.0 (06/2022)
1.0.1 (11/2022)
1.1.0 (11/2023)
1.2.0 (04/2024)
1.3.0 (10/2024)

1.3.1 (04/2025)
1.3.2 (11/2025)

Version: 1.3.2

Changes

Edition

New software version V1.4.0, new firmware FIR-v2213

New software version V1.5.2

New software version V1.6.0

New software version V3.1.7 (1.7.0 according to the old versioning).

Modbus TCP support added.

Firmware and OD file can now be directly downloaded from cloud, see Select the

OD file.

New software version V3.1.8
New software version V3.1.9.

New chapters Scripting Module and NanoJ App.

PNDS3
V1.3.0
V1.4.0
V1.5.2
V1.6.0
V3.1.7

V3.1.8
Vv3.1.9
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